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Introduction

Java Heap dump contains a list of all the objects that are in a
Java heap.

Java Heap dumps could be very large (as much as giga bytes)
It's not always easy to analyze large dumps.

IBM HeapAnalyzer can analyze IBM Java heap dumps from
Java SDK 1.3.1 and 1.4.x.

IBM HeapAnalyzer is provided “as-is”.

The top download for 11 consecutive months from the
alphaWorks Java technology website
(http://www.alphaworks.ibm.com/java) as of September 2005
Used by over 2,000 companies, government agencies,
research facilities and universities worldwide

Now integrated with WebSphere Application Server V6.0.2
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Prerequisite

= Java 2 SDK/JRE 1.4.1 or higher for runtime of HeapAnalyzer
= The following exception will be thrown if older versions of
SDK/JRE are used:

Exception in thread "main" java.lang.NoClassDefFoundError:
java/util/regex/PatternSyntaxException

= |IBM Java heap dump generated from IBM SDK 1.3.1 or 1.4.x
= For more information about getting IBM Java heap dump,

refer to MustGather: Out of Memory errors on Windows
http://www-1.ibm.com/support/docview.wss?uid=swg21140641
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Features

Creates a tree from Java
heap dump

Calculates size of each
objects

Calculates total size of each
subtree

Finds size drop in a subtree
Shows gap by size

Shows objects by size
Shows objects by total size
Shows objects by number of
child

Shows types by size

Shows types by count

WebSphere® Support Technical Exchange

Shows types alphabetical
order

Shows gap distribution
Shows detailed information of
an object

Finds type with regular
expression

Drag and drop support in
input fields and text
Bookmarks in tree navigation
Saves/Loads processed heap
dumps

Locates possible leak
suspects
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How does it work?

= Reads IBM Java heap dump file and parse each
object/class information

= Creates graphs based on parsed information

= Creates trees based on the graphs

= Runs Java heap leak detection engine to display
suspected Java heap leak areas
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What is IBM Java heap dump

= IBM Java Virtual Machine facility generates a
dump of all the live objects that are on the Java
heap; that is, those that are used by the Java
application. This dump is called a IBM Java Heap
dump. It shows the objects that are using memory
space on the Java heap.

WebSphere® Support Technical Exchange



| IBM Software Group

Text dump structure

=/l Header : build identifier
of the JVM that produced
the dump.

Address of object

Size of object

Name of object
References of objects

/| EOF : summary of the
heap dump

/| Version: J2RE 1.3.1 IBM Windows 32

build cn131-20020923
0x30000080 [10000] G

0x50001010 [6000] A

0x50002020 [4000] B
0x10007030 0x50006040 0x50004050

]

0x50004050 0x 30000080
0x50004050 £1 104] C
0x50005060
0x50005060 [1032] D
0x50003090 0x50005060
0x50006040 [1904] |
0x10007030
0x10007030 [1024] J

0x50003090 [504] E
0xF00090A0 0x50003070
0xF00090A0 [0032] H

0x200000B0 [40000] K
0x50002020 0x200000C0

0x200000C0é8000] L
0x200000B0

I EOF: /I
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How to generate IBM Java heap dump

= IBM Java Heap dump can be generated in either of two ways
» Explicit generation

» Java Virtual Machine triggered generation

= When the Java heap is exhausted, Java Virtual Machine triggered
generation is enabled by default.

= To enable signal-based Java Heap dumps, the
IBM_HEAPDUMP=TRUE environmental variable or the appropriate
JAVA DUMP_OPTS must be set.

WebSphere® Support Technical Exchange



| IBM Software Group

Explicit generation

= IBM Java Heap dump can be explicitly generated in either of the
following ways

» By sending a signal to the JVM from the operating system

» By using the HeapDump() method inside Java code that is
being executed

= For Linux and AlX, send the JVM the signal SIGQUIT (kill -3, or
CTRL+\ in the console window).

= For Windows, generate a SIGINT (press the Ctrl+Break keys
simultaneously).
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Java Virtual Machine triggered generation

= The following events automatically trigger the JVM to produce
a Java Heap dump

» A fatal native exception occurs in the JVM (not a Java
Exception)

» An OutOfMemoryError or heap exhaustion condition
occurs (optional)

= If Java Heap dumps are enabled, they are normally produced
immediately before a thread dump. They are produced also if
the JVM terminates unexpectedly (a crash).

WebSphere® Support Technical Exchange



| IBM Software Group

Location of IBM Java Heap dump

= The JVM checks each of the following locations for existence
and write-permission, then stores the Heap dump in the first
one that is available.

» The location that is specified by the IBM_HEAPDUMPDIR
environment variable, if set

» The current working directory of the JVM processes

» The location that is specified by the TMPDIR environment
variable, if set

» The /tmp directory (X:\tmp for Windows, where X is the
current working drive)
= Note that enough free disk space must be available for the
Heap dump file to be written correctly.

WebSphere® Support Technical Exchange



| IBM Software Group

Format of Heap dump filenames

= Note: PID is the process ID. TIME is the number of seconds since

1/1/1970
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Creating a graph
0x30000080 [10000] G

0x50001010 [6000] A
0x50002020
0x50002020 [4000] B
0x10007030 0x50006040 0x50004050
0x50003070 [1000] F
0x50004050 0x30000080
0x50004050 [1104] C
0x50005060
0x50005060 [1032] D
0x50003090 0x50005060
0x50006040 [1904] |
0x10007030
0x10007030 [1024] J

0x50003090 [504] E
0xF00090A0 0x50003070
0xF00090A0 [0032] H

0x200000B0 [40000] K
0x50002020 0x200000C0

0x200000C0 [8000] L
0x200000B0
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Definitions

Root object An object for which no (different) object holds a reference.

Parent object An object (for example, A) that holds at least one reference to some
(different) object (for example, B). In this case, A is said to be the
parent of B.

Owner object If an object has more than one parent object, a parent object is chosen
as owner object. Total size is calculated only with owner objects.

Child object An object (for example, B) for which at least one (different) object
(for example, A) holds a reference. In this case B is said to be the child of A.

Type Collection of same objects

Size The size of an object is the amount of memory that is required to
hold that objectin memory.

Total size The subtree size of an object is the sum of its size and the sizes of

all the objects that it reached from its children. Note that each object is assigned a
unique parent and root during processing. If there’s substantial difference in total size
between a parent and its child, it's called a total size drop.
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Creating a tree with DFS

= |BM HeapAnalyzer |:| |§| |E|

File Analysis View Help

heapsampletxt Tree View §§

= Create a tree from the previous
graph using Depth First Search
(DFS) algorithm

= Sorted by Total Size

Go to Bookmark Remove Bookmark Leak Suspects

| TotalSize [Size] MumberOfChildObject(2) Mame Address
o [C] 48,000 [40,000] 2 K 0x200000k0
% [ 8,000 [8,000] 1 L 0x200000c0
o= 48,000 [40,000] 2 K 020000000
o= 4 20,600 [4,000] 3 B 0x60002020
9 [ 26,600 [6,000] 1 A 0x50001010
¢ [ 20,600 [4,000] 3 B 0x50002020
o CJ13,672[1,104] 1 C 050004050
9 [J 12,668 [1,032] 2 D 050005060
9 [ 11,536 [504] 2 E 050003090
e |j|1 1,000 [1,000] 2 F 50003070
B 10,000 [10,000] 010G Dx300000a0
o= SIS ETZ 1 ,104] 1 C Ox5a0004050
D 32 [32)0H Oxf0o090a0
o= 4 12 868 [1,032] 2 D 050005060
o 31,904 [1,904] 1 | Ox&0006040
< 1,024 [1,024] 00 010007030
B 1,024 [1,024] 0J 010007030

HeapAnalyzer View Heap dump Tree sorted by Total Size

o I Ld - .
+ )
S . » ., [ & A,
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How do | run HeapAnalyzer?

= . IBM HeapAnalyzer
File Anahrsis View Help

Console

WebSphere® Support Technical Exchange

= Usage <Java 2 SDK path>java —
Xmx[heapsize] —jar
ha<HeapAnalyzer version>.jar
For example, java —Xmx1000m —
jar ha135.jar

= If you see
java.lang.OutOfMemoryError
while you are processing
heapdumps, please try increasing
the maximum heap size (-Xmx)
value to give the JVM more
memory.

= Maximum heap size should not
be larger than the size of
available physical memory size
for this tool due to performance
issue.
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File Menu

£ . IBM HeapAnalyzer
Analysis VYWiew Help

Console

Heaphnahrzer |Dpen a heap dump txt, t=t.gz, .phd or .ha ﬁlel

WebSphere® Support Technical Exchange

= Open a heap dump
(Automatically detects various
formats of IBM Java heap
dumps, for example text,
compressed text, portable
heap dump and HeapAnalyzer
format)

= Save processed heap dump

= Exit
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Look In: | ] WehSphere51 v @ @ @ ’E = Select File -> Open
= and select a Java
server h mp fil
] DeploymentManager eap dU p e
] IBMHttpServer
File Name: |
Files of Type: | All Files (*.") A4
Open Cancel

WebSphere® Support Technical Exchange
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Open a processed heap dump

2 Load processed heap dump

Look In: ] My Documents "‘ @ @ @

X

[

] Bluetooth Exchange Folder
3 1BM

] My eBooks

] My Music

1 My Pictures

1 Security

File Name:

Files of Type: |HeapAnalyzer Files {.ha)

Load processed heap dump

Cancel

= If you have a processed
heap dump, select
File -> Open
and select a processed
heap dump file which
has .ha extension.

WebSphere® Support Technical Exchange
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Processing heap dumps

= Progress is shown during
processing heapdump.

E'E-E Analyzing Heap Dump
Unit progress

Loading heap dump file ...

Overall progress

0%

WebSphere® Support Technical Exchange
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Processing completed

= IBM HeapAnalyzer |:| |E| |ﬁ|

File Anahlssis Wiew Help

heapdump1.ha

Heap dump comments :
Myersion: J2ZRE 1.3.1 IBM ALK build ca131-20030618
TEOQOF: Total: 3229668 Classes: TEO0 Objects: 2910270 Oh
Mumber of roots 159,549
MHumber of types 10,664
Heap range : 030070200 to 0x7Fa3dzba1a

= = Rl i i

eap size 119,180,536

HeapAnahzer | Open a heap dump t=t, t=t.gz, .phd or .ha file

WebSphere® Support Technical Exchange

= This is the screen when
processing is complete.

= Please do not close this
window until you do not
need this heap dump.
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Analysis Menu

2 IBM HeapAnalyzer

(=13

m Yiew Help

Ohjects List
Types List

WASRUMTools\HeapAnalzened

Gaps by size
Gap Statistics

ol AL build ca121-20030618
asses: 700 Ohjects: 2910270 Oh
=]

Search

]

0to Oxra32bha1i

= I'\.’lllH'\_— et e T T
Heap randge size @ 1,244,
Heap size ;119,180,536

378,136

HeapAnalyzer Yiew Heap dump Tree sorted by Total Size

WebSphere® Support Technical Exchange

= Click on Analysis menu and
select a menu item for
further analysis.
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Tree view

] heapdump1.ha Tree View Sa = The check icon indicates

Go to Bookmark Remove Bookmark Leak Suspects that H
it has already been
| TotalSize [Size] MumberOfChildOhjecti1 59,549 Mam y

¢ [CJ 97,290,640 [200] 2 carmfibrafmmifiiopiCDROUtpULS included as a child ObjeCt of

o= [ 97,290,416 [328] 25 comlibmiCORBANiopiOR owner object in tree view
[ 24 [24] 0 comiibmirmifiiopiCharToTesLatind 0

o= ] 309,056 [256] 3 class javaiutifjarJarFile Ox7 007 ¢ - EaCh tree nOde as in the

o= [ 193,248 [256] 22 class comfibrirmisutiliUtility 0x7 fo||owing format:
7 |j|1 34112 [32] 4 javalanofrefiFinalizer D}:SDDdEEleEI|

o= [ 134,016 [32] 4 javallandgirefiFinalizer 0x300ekk TOtaISize[Size]
o= [ 64 [32] 4 javallangireffFinalizer 0x300d6a10 NumberOfCh”dObJeCt

o= A0 [24] 1 javallangfreffReferencelueaue Ox300

o~ 4 32 [16] 1 cormiibmijvrmiioFileOutputStrearm 0x Name Address
o= [ 107,808 [256] 20 class comfibmdrmifiodObjectStre
o= [ 99,800 [256] 8 class comfibmirmifiiop/CDROutpul
o= [ 71,400 [256] 2 class javatextiDateF ormatSymbols
o= [ 70,096 [256] 1 class comfibrmirmifionsalueHandle
o= [T] 67,240 [256] T class java'beanslintrospectar 0x7F7
o= [ 58,312 [256] 60 class comiibmirmifutilfRepositorn
o= [ 50,544 [256] 1 class sundia’CharacterEncoding III}1,,

Heapinahzer Yiew Heap dump Tree sorted by Total Size

WebSphere® Support Technical Exchange
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Detailed Node Information

=  |IBM HeapAnalyzer

" Intree view, you can see

—————— detailed information of a

Go to Bookmark Remove Bookmark Leak Suspects nOd e

| TotalSize [Size] MumberOfChildObject{159,549) Mam - YOU can SeaI’Ch for total

% [ 97,290,640 [200] 2 comitbrmirmifiiop/COROutputs

o= [ 97,290,416 [328] 35 comiibmiC ORBAfiopfOR size drop between parent

|j| 24 [24] 0 comfibrmfrmifiiopiCharmoTeslating 0

o= ] 309,056 [256] 3 class javaiutifjarJarFile Ox7 007 ¢ and Chlld Or you Can fl nd an

o [ 193,248 [256] 22 class cormfibrmirmifutiliility 0x7 address by Se|eCtIng a nOde
¢ Cd134,112 [32] 4 z irali =10

- 3134016 [ and clicking on right mouse

o= [ G4 [32] 4| Gotothe largest drop in subtrees
o= . 40 [24]1] N : button.
o= . 32[16E] 1
o- ] 107,808 [256
o~ [ 99,800 [256] § Detailed node information
o= [ 71,400 [256] ] Find an address
o [J 70,0496 [256] | Show more children
o= [ 67,240 [256]
o [ 58,312 [256]
o= [ 50,544 [256]

Locate a leak suspect
Compile leak suspects

Show more parents
Show from roots
Add Bookmark

WebSphere® Support Technical Exchange
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Detailed Node Information

= IBM HeapAnalyzer |:| |§| |E|

File Analysis YWiew Help

heapdump1.ha Tree View

Go to Bookmark Remove Bookmark Leak Suspects

| TotalZize [Size] MumberOfChildObject{159,549) Mam
¢ [ 97,290,640 [200] 2 comfibrmirmidfiiopfCDROutputs
o= Q7,290,416 [328] 25 comiibmfCORBASNTopi DR

‘ 3 A1 11 O BT E T 11 -1 5 n =hila [ |
javalang/refFinalizer at 0x300ebb20 o = [

“ddress  Dx300ebb20

Chject : javaflanagireffFinalizer
rumber of children ;4

Crwvier address: Ox300dE9a0
Crwvrier object: javallangfrefiFinalizer
Sizre ;32

otal size ;134,016

o= ] 71,400 [256] 3 class javafiextDateF ormatSymbols
o- ] 70,096 [256] 1 class camfibrmirmifionsalueHandle
o= [ G7,240 [256] T class javafheansintrospector Ox7 7
o= ] 58,312 [256] B0 class comfibmirmifutidRepositon
o= [] 50,544 [256] 1 class sunficfCharacterEncoding Ox

HeapiAnahZer |view Heap dump Tree sorted by Total Size

WebSphere® Support Technical Exchange

= This is the screen of
detailed node information in
heapdump tree
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Find an address

= You can find an address

;'EE‘; Find an address ‘:.
maseAmaranadviass e HelieG) selecting the menu “Find
:|FK3DDTEEED an address”

WebSphere® Support Technical Exchange
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Found the address

heapdumpi.ha Tree View :

G0 to Bookmark Remove Bookmark Leak Suspects

9 [ 107,808 [256] 20 class comdibrmdrmifiodObjectStre
o= [ 105,136 [264] 34 array of comdibmifrmifiofOhbje
o= [ 2,048 [48] 1 javaiutilHashtahle Ox36a12e30
o= [ 176 [48] 5 javallangireflecttethod Dx36a1 2ef0
o= 112 [32]1 javalana!String 0236212810

|j| |1 B [16] O array of javallang/Object Dx36a1 27490
|j| 16 [16] O array of javallangiClass Ox36a1 2780
|j| 16 [16] 0 comfibmfrmifiafCohbjectStreamClasss
|j| 16 [16] 0 comfibmfrmifiafCohbjectStreamClasss

|j| 16 [16] 0 comfibmfrmifiafCohbjectStreamClasss

o= ./ 39,576 [256] 4 class javalioObjectinputStrear
o= . 38,704 [256] 10 class javaliolDbjectStreamCls
o= . 392 [256] 2 class javallaniClass 070070118
296 [296] 0 class argfomof/CORBADBject Ox7 S

296 [296] 0 class javallang/Object OxF007 021

286 [296] 0 class javaliofSerializable Ox70070

286 [296] 0 class javalio/Externalizable 0x7 413

296 [296] 1 class javaliofObjectOutputstream

OSs as 1 N 1 RPN Pl i Li—r= L=l O PO 200

WebSphere® Support Technical Exchange

= This is the result of address
search in a tree view
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Add Bookmarks

= . |IBM HeapAnalyzer |z| |§| |E|

File Analysis WView Help

heapdumpi.ha Tree View :

= You can bookmark nodes
Go to Bookmark Remove Bookmark Leak Suspects and Continue to navigate

¢ [ 107,808 [256] 20 class comfibmirmificdobjectStre| =
o [ 105,136 [264] 34 array of corfibrirmiio/Okje tree

o= [ 2,042 [48] 1 javaliutifHashtahle 0x36a12e30
o= ] 176 [48] 5 javalangireflectethod 0x36a1 2ef0
o= 112 [32]1 1 javalang/String 0x36a12810

|j| 16 HE]D arre—=tisnsdlon sl e tﬁ I T e b m T
|__”*| 16 [16] 0 arra Search for total size drop

EI 16 [16] 0 con Go to the largest drop in subtrees

|j| 16 [16] 0 cor Locate a leak suspect
[y 16 [16] 0 conCompile leak suspects

o= ./ 39,876 [296]] Detailed node information
o= . 38,704 [256]
e 7 392 [296] 2 o
256 [256] 0 g Show more children
< 256 [256] 0  Show more parents
o AR [256] 0
«F 286 [286] 0

Find an address

Show from roots

o 7 256 [256) 1 GG BOOKMark |

-
P Tl = i -l = B 1 P A i Li—r—= L= 1 (m ] _.-'l'll'l_.-'l'll

1 ] b

HeapAnahrzer view Heap dump Tree sorted by Total Size
= I = P
E . E ] S

WebSphere® Support Technical Exchange
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Bookmarks

- heapdump1.ha Tree Yiew

Remove Bookmark | eak Suspects

ormlibmirmifiofOhbjectStre

o= 1 1059,136 [Xad] 34 array of comdibmifrmifioi2hje
o= [ 2,048 [48] 1 javaiutifHashtable 0x36a1 2230
o= [ 176 [48] 5 javalanaireflectMethod Ox36a1 2cfD
o= 112 [22] 1 javalang/String 0x36a12810
|:"| 16 [16] O array of javallangfObject Ox36a1 2730
|:’*| 16 [16] O array of javallanglClass Dx36a12720
|j‘| 16 [16] 0 comfibmirmificsObjectsStreamClassh
|:’*| 16 [16] 0 comfibmirmifiofObjectStreamClassh
|:’*| 16 [16] 0 comfibmirmifiofObjectStreamClassh

OGN ANNNS

39,8976 [296] 4 class javaliombjectinputStrear
38,704 [256] 10 class javafiofObjectStreamcls
392 [256] 2 class javalflangiClass Ox70070118
286 [256] 0 class ardgfomgiZORBAYNObject O0x7 Y
266 [256] 0 class javallana/Ohbject 0xFO007021
266 [256] 0 class javalfiofSerializable O0xFO0070
286 [256] 0 class javaliofBExternalizable 0x7 4fa
286 [256] 1 class Java.l'lDIDhJectOutputEtream

b Il e e -l e B | 1 PP H ol ) i Li—r— L= 1 [ Pl e w |

WebSphere® Support Technical Exchange

= You can see list of
bookmarks in “Go to
Bookmark” menu in Tree
view menu bar
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Remove Bookmarks

G0 to Bookmark

e[ 107,808 [25
o= [ 105,136 [Z64] 34 array of comibrmirmifiofObjec
o= 2,048 [48] 1 javaiutifHashtable Ox36a12e30
o= [ 176 [48] 5 javallangireflectiMethod 0x36a1 2cf0
o= 112 [322] 1 javallanaiString 0x36a12810

|j| 16 [16] O array of javallang/Dhject Ox36a1 27490
|j| 16 [16] 0 array of javallangiClass Ox36a1 2720
|j| 16 [16] 0 comfibmirmifiorObjectStreamClassd
|j| 16 [16] 0 comfibmirmifiorObjectStreamClassd
|j| 16 [16] 0 comfibmirmifiorObjectStreamClassd

o
o
o

39,4876 [296] 4 class javaliofOhbjectinputstream
32,704 [296] 10 class javaliofObjectStreamCla
3972 [246] 2 class javallanoiClass OxF00701183
296 [256] 0 class orfomofCORBAI O bject OxFS
296 [256] 0 class javallangiChject 070070215
296 [256] 0 class javaliorSerializable Dxr007 04
296 [256] 0 class javaliofBExdernalizable OxT 4136

296 [256] 1 class javaliofObjectOutputStream O

o -l ol i -l ol B | 1 i et ol ) i Li—r— b=l Dy PO d

WebSphere® Support Technical Exchange

= You can remove bookmarks
in “Remove Bookmark”
menu in Tree view menu
bar
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Got more children?

IBEM HeapAnalyzer
File Analysis Wiew Help

heapdump1.ha Tree View |

Go to Bookmark Remove Bookmark |eak Suspects
[ | i R [ ) R Y P e e R P S ] ) ) e N B T B B ]

w 286 [286] 0 class javaliofExernalizable 0x7 4Tae

W 286 [256] 0 class java/rmilRemote Oxr525581
o= [ 99,800 [256] & class comdibmirmidfiioprS DR Output
o= [ 71,400 [256] 2 class javatextiDateF ormatSymbal s
o= [0 70,096 [256] 1 class carmdibmirmifiotalueHandler
o= ] 67,240 [256] 7 class javafheansintrospector Ox7F 7
o= [ 58,312 [256] 60 class comdibmirmifutilR epositary
o= [ 50,544 [256] 1 class sunfiofCharacterEncoding Ox
o- [ 43,592 [256] 2 class javalutiNTimeZoneData 0x7 41
o= ] 43,368 [256] 16 class comfibmiCORBAiop/tID e
o= ] 40,088 [256] 2 class javalioiObjectStreamClassE2
o= [ 36,624 [124] 2 comiibrmirmifiiopiC DR InputStream
o= [ 34,192 [134] 8 comiibmirmifiiopiCORInputStream
o= [ 28,584 [256] 5 class javainet/URLConnection Ox74
o= [ 25,480 [24] 2 javallanoiClasshotFoundException 0
o= [ 21,832 [64] 1 javaiutiiHashMap 0x303324d8
o= 18,544 [134] & comiibrmirmifiiopiCDRInputStresm
o rokt There are 159 529 more children |

Heapinahzer Yiew Heap dump Tree sorted by Total Size

WebSphere® Support Technical Exchange

= |f you have more children in
a parent object, you can see
how many more children
are hidden

= By expanding the node, you
can see more children
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More children

IBEM HeapAnalyzer

File Analysis Yiew Help

heapdump1.ha Tree View

Go to Bookmark HRemove Bookmark |eak Suspects

o- [ 40,088 [256] 2 class javalioiOhjectStream ClassE2
o= ] 36,624 [184] & camdibrmirmifiiopiCDRInputStream
o= 5] 34,192 [184] & comdibrmirmiliiopdC DR InputStream
o- [ 28,584 [2596] 5 class javametJRLConnection Ox74
o= 5] 25,480 [24] 2 javalanafClassMotF oundException O
o= [ 21,832 [64] 1 javaiutiHashMap Ox303324d8
o= [5] 18,544 [184] & comdibrmirmifiiopiCDRInputStream
o= 17,808 [124] & comdibmirmifiiopdCDRInputStream
o= 5] 17,808 [184] & camdibrmirmifiiopiCDRInputStream
o= 17,712 [1284] & comdibmirmifiiopd!CDRInputStream
o= 17,712 [184] 2 comdfibrmirmifiiopiCDRInputStream

|j| 16,400 [16,400] O primitive array Dx3ecalstl

|j| 16,400 [16,400] O prirmitive array Ox32641e70

|j| 16,400 [16,400] O primitive array Ox300c4 220
o= 15,768 [2596] 2 class sun/netvwwwwprotocalljariJarF
o= [T 14,888 [256] 2 class javallang/Package OxTO0TIE
o= 910,120 [304] 17 comdibmirmifiioprServerReguestin
o meke There are 159,519 rmore children |

WebSphere® Support Technical Exchange

il

= 10 more children are
displayed



| IBM Software Group

Another way to display more children

£ . IBM HeapAnalyzer |Z| |E”E|

heapdump1.ha Tree Wiew
GO0 to Bookmark Remowve Bookmark | eak Suspects

- =y

|j| 16,400 [16,400] O pritnitive array 0x2300c4 220 ]
o= [ 15,768 [256] 2 class sun/nethwwasiprotocolfjan
o= [ 14,8288 [256] 2 class javalana/Package 0x700
o= 310,120 [204] 17 camdibmirmifiioprServerRegu
o= Mokt Thare gre 159 518 mare children
1 I Search for total size drop

G0 to the largest drop in subtree:

ALl

Locate a leak suspect
Compile leak suspects

Detailed node information
Find an address

Show more parents
Show from roots

Add Bookmark
b ] 3

HeapAnahzer (Wiew Heap dump Tree sorted by Total Size

E I -. - .
A > . e,

= You can use “Show more
children” menu from parent
node

WebSphere® Support Technical Exchange
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Locate a leak suspect

File Anahlysis YWiew Help

. heapdump1.ha Tree YWiew :_:_

2. IBM HeapAnalyzer |Z| |E| |E|

Go to Buukmark Flemuve Buukmark Leak Suspects

o= 43 363 [25Ei] 16 class cnmnhmICDHBNHDpIUtHDE
o= [ 40,088 [266] 2 class javaliofObjectStreamClassE2

o (33 Search for total size drop Strearm
o= ] 3 i Stream
T 2 Go to the largest drop in subtrees ian 0wT 4
~9of Locatealeaksuspect lupions
o ] 21 Compile leak suspects g

> 114 petailed node information Strearm

-1 Find an address SIEELL

o= 717 Stream

- 91 Showw more children Stream

o 1] Show more parents Stream | =
|j| 14 Show from roots 0
[ 1¢ Add Bookmark bl

|j| 16,400 [16,400] 0 prirmitive array 0x300cd4220
o= [ 15,768 [256] 2 class suninethvwwwrprotocaolijarlarF
o= [ 14 888 [256] 2 class javalang/Package OxFOOTE

—== . " r a1 a— - ' e ' —

—

WebSphere® Support Technical Exchange

Heapnnalyzer MFEW Heap dump Tree surted Iy Total Size

= You can locate areas where
Java heap leak is suspected
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Found a leak suspect?

= |IBM HeapAnalyzer

File Analysis Wiew Help

heapdumpi.ha Tree View -

G0 to Bookmark Remowve Bookmark | eak Suspects

| TotalSize [Size] MumberOtZhildObject(1 59,5497 Mam
e [ 97,290,640 [200] 2 comfibmirmilfiiopfCDR Outputs
o [ 97,290,416 [228] 25 comiibmiCORBASiop/OR

¢ [ 70,073,112 [48] 6 comiibmiejsioalEJSRoo

o [ 69,572,704 [24] 1 comiibmifejsiutilF asi

¢ [ 69,572,620 [62,064] 17,011 array o

o- |j|.‘-",895,295 [24] 2 combibmilejsiul
o= ] 7,890,368 [24] 2 comiibmiejsiul
o- [[5] 7,884,320 [24] 2 comiibmiejsiul
o= [ 7,878,272 [24] 2 comiibmiejsiul
o= 5] 7,878,048 [24] 2 comifibmiejsiul
o= [ 7,870,880 [24] 2 comfibmiejsiul
o= ] 744,432 [24] 2 comfibrmfejsiutil
o- [ 744,096 [24] 2 comdfibrmfejsiutil
o= [ 744,096 [24] 2 comfibmfejsiutil
o= [5] 744,096 [24] 2 comfibrmfejsiutil
o= [ 744,096 [24] 2 comfibrmfejsiutil
o= 5] 743,760 [24] 2 comfibrmfejsiutil

HeapAnalyzer vYiew Heap dump Tree sorted bnr Total Size

Fous~ » Nl

WebSphere® Support Technical Exchange

= Found an area where there

are relatively excessive
number of children
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Compile leak suspects

IBM HeapAnalyzer

File Analrsis YWiew Help
-

heapdump1.ha Tree View :

G0 to Bookmark BRemowve Bookmark Leak Suspects

i 24497 Harme Ac
Search for total size dro
o 7 P ROutpUIStrea

o Go to the largest drop in subtrees , OxFO007c0 S

o- 7 Locate aleak suspect LHility 0T 1

[ petailed node information HhjectStream

Find an address DROutputstry—

o 7 ) atSvmbols Ox]
- Show more children ueHandlerFo

o Show more parents s ctor X7 7 3cE
o- & Show from roots Repoasitaryld O
o [ Add Bookmark ncoding 0x7 41,
o [ 33897 [aE] Z Class [avalutifTimeZoneData 0x74fa3c
o= [ 43,368 [256] 16 class comiibhmiCORBANiop/UtiIIDeleg
o= [ 40,088 [256] 2 class javaliofObjectStreamClass§2? Ox
o= [ 26,624 [184] 8 comfibmirmifiiop/CDRInputStream 0x3
o= [ 24,192 [184] 8 comfibmirmifiiop/CDRInputStream 0x3

WebSphere® Support Technical Exchange

= You can compile list of
locate areas where Java
heap leak is suspected
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Locate a leak suspect

= |BM HeapAnalyzer

FEX

File Anahsis View Help
o ©

heapdump1.ha Tree View

Go to Bookmark Remowve Bookmark _

[ TotalSize [Size] Mumber2fChildOhjec
o [ 97,290,640 [200] 2 comiibmirmifii
o= [ 209,056 [256] 3 class javaiutiljar
o= [ 193,248 [256] 22 class comiibmn
o= [ 134,112 [32] 4 javailang/refiFinaliz
o= [ 107,808 [256] 20 class comiibmin
o- [ 99,800 [256] 8 class cam/ibm/rmi
o= [ 71,400 [256] 3 class javatextDate
o= [ 70,086 [256] 1 class comibmirmi
o- [ 67,240 [266] 7 class javalbeans/

69,572,680 array of comibm/ejsiutilBucket

7,893,088 array of comibmrmiitildentityHashtableEntry
7,888,160 array of comibmirmintdilldentibyHashtableEntry
7,882,112 array of com/ibm/irmintilldentibHashtableEntry
7,876,064 array of comibm/rmiitilldentityHashtableEntry
7,875,840 array of comibm/rmiintidentityHashtableEntry
7,868,672 array of comiibmirmintdilldentibyHashtableEntry
3,599,776 array of java/utiiHashMap $Entry

2,632,272 array of javautilHashMap$Entry

o= [ 58,212 [286] 60 class comiib Mt proormorreorr o oo

o= [ 50,544 [266] 1 class sunfiofCharacterEncoding 0x7 4fa9418

o= [ 43,592 [246] 2 class javalutiliTimeZoneData 0x74fa3d18

o= [ 43,368 [266] 16 class comfibmiCORBAGiop/UMtilDelegatelmpl 0x76112a18
o= [ 40,088 [256] 2 class javaliofObjectStreamClass$2 0x7 4fach 8

o= [ 26,624 [184] 8 comfibrmirmifiiopCDRInputStream 0x301 7621 8

o= [ 24,192 [184] 8 comfibrmirmifiiopfCDRInputStream 0x31hEF38

o= 7] 28,554 [256] 5 class javanetURLConnection 0x74fad9218 =

HeapAnalyzer Yiew Heap dump Tree sorted by Total Size

WebSphere® Support Technical Exchange

= You can locate
areas where
Java heap leak
IS suspected by
selecting a leak
suspect




Search for total size drop

| IBM Software Group

= IBM HeapAnalyzer

File Analrsis YWiew Help

e
o= [ 20
o-[]149
o-]13
o110
o [] 88
o 71
o 70
o ] 67
o= [] 58
o= ] 50

o= [0 43 5Y7 [Z8E6] 2 class [avalutii imesonelata 0x7
o= [0 43,368 [256] 16 class comiibmi S ORBASiopsiID
o= [ 40,0288 [256] 2 class javaliofObjectStreamClass
o= [ 36,624 [184] 8 comdibmirmifiiop/C DR InputStrearn
o= [ 34,192 [184] 8 comdibmirmifiiop/C DR InputStrearn

Go to the largest drop in subirees
Locate a leak suspect
Compile leak suspecis

Detailed node information
Find an address

Show more children
Show more parents
Show from roots

Add Bookmark

“Search for total size drop”
will find a size drop between
the total size of a parent
and the biggest total size of
child of the parent.

If you cannot find any size
drop from the menu “Search
for total size drop”, you
need to decrease Minimum
total size drop for search in
options.

WebSphere® Support Technical Exchange



| IBM Software Group

Gaps by size

Tree view

Objects List ove Bookmark |Leak Suspects

Types List herOfChildObjecti153, 546 Mam
[ﬁz cormfibrmsrmifiiopfCDROutputs
Gap Statistics 28] 28 comfibmfCORBASTORIOR
Searcn 714310 comimeysioaitioron
¢ 69,572,620 [62,064] 17,011 array o

o- [ 7,895,296 [24] 2 comfibmiejsiu

o- [ 7,890,262 [24] 2 comdfibmlfejsiu

o= [ 7,884,320 [24] 2 comdfibmiejsiui

o= [ 7,878,272 [24] 2 comdibmiejsiul

o= [ 7,878,042 [24] 2 comdfibmiejsiud

o= [ 7,870,880 [24] 2 comfibmiejsiul

o= 5] 744,432 [24] 2 comfibrmlejsiutil

o= [ 744,096 [24] 2 comfibmiejsiutil

o= ] 744,096 [24] 2 comfibmiejsiutil

o= [ 744,096 [24] 2 com/fibmlejsiutil

o= [ 744,096 [24] 2 comfibmiejsiutil

o- [ 743,760 [24] 2 comfibrmlfejsiutil

WebSphere® Support Technical Exchange

= You can review gaps
between objects and
classes
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Gaps view

IEM HeapAnalyzer

File Analysis Yiew Help

heapdump1.ha Gaps between objects - o o [ - P H
Gap sice ¥ MNext address ThIS IS gaps VIeW

205 FES 120 Oxyooyoola
a2 4968 332 Ox74fa0013
49 611,008 Oxya3izooa
15,401,216 OxyE110013
2,519,936 Ox7¥3conls
5,505,230 Ox7EEROOT S
5,374,208 Ox7Bha001 2
2,752 768 Oxya2500143
133,464 Ox3fffeden
34 368 Ox38af00ra
a4 136 Ox35eeck
33,808 Ox3aZc2100
233,456 0x2r3Z2b0e8
233,336 Ox27ardren
33,184 Ox37¥ed2aa
33,080 Ox3cd6EaEe40
33,0586 Ox3edaa22a
32,4952 Ox3cesfhan
32,920 Ox3aed 20
31,568 O0x23fd16d18
29192 Ox3afacy 748

HeapAnalyzer|Sort gaps between ohjects by size

WebSphere® Support Technical Exchange
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Objects List

o Hienndnalvaen LEX

= List Objects -> Sort by
- 5 TotalSize

Types List

p Bookmark | eak Suspecis

aerOfChildObhject{1 59,549 Mam
Gaps by size 2 comdibmirmifiinpi S DR Outputs
Gap Statistics 28] 39 comfibmiCORBASTIopiOR
Searcn ___ 4815 comure o onon
o [ G9,A72,620[62,064] 17,011 array o

o= [ 7,895,296 [24] 2 comdfibmiejsiul

o= [5] 7,890,368 [24] 2 comfibmiejsiul

o= [ 7,884,320 [24] 2 comfibmiejsiui

o= [ 7,878,272 [24] 2 comfibmiejsiul

o= 5] 7,878,048 [24] 2 comdfibmiejsiul

o= [ 7,870,880 [24] 2 comfibmiejssiul

o= 5] 744,432 [24] 2 comdibrmlejsiutil

o= [ 744,096 [24] 2 comfibmlejsiutil

o= [ 744,096 [24] 2 comfibmlejsiutil

o= [ 744,096 [24] 2 comdibrmfejsiutil

o= [ 744,096 [24] 2 comfibmlejsiutil

o= [5] 743,760 [24] 2 comdibrmlejsiutil

WebSphere® Support Technical Exchange
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Objects by TotalSize

= IBM HeapAnalyzer

File Analysis View Help

heapdump1.ha Objects Wiew

TotalSize ¥

Size

Mo, Child

Address

67 200 640

200

2

Ox3016d7h0

carmfibrmsrmis...

87,200,416

328

35

Ox36865a30

carmiibrmico, .

70,073,112

43

]

Ox36733050

cormfibimifejsi. .

9,572,704

24

1

Ox367eb168

cormfibimifejsi. .

F9,572 650

BS,064

17,011

Ox36 73003

array of comifi...

26,746,056

g0

T

Ox367774ba

carmfibrmsrmis...

26,745,872

112

15

Ox300c3f7 8

carmiibimbness..

25 057,016

32

1

Ox303e10cd

javalutil®ectar

25 056,954

40,976

Ox30d7d700

array of javarl. .

18,423,704

256

i

Ox300khee10

class comiib...

18,372,256

32

Ox305de01 8

cormfibimifejsi. .

18,210,554

43

Ox305ddfE0

javalutiliMHas .

18,210,536

B4

Ox305ddf20

array of javar. ..

18,208,760

32

Ox3196d808

javalutiliMHas .

18,200,600

32

Ox3196d860

javalutil®ectar

18,200,568

a6

Ox3196d828

array of javarl. .

18,200,512

Ox31981310

cormfibimifejsi. .

18,151,760

43

Ox31987a20

cormfibimifejsi. .

17,320,080

Ox316eZek0

cormfibimifejsi. .

17,031,936

g0

Ox36091520

cormfibimifejsi. .

17,027,760

V2

= w|w[@m - ===

Ox35fd 07 cO

Heapanahlzer|List of Objects sorted in various order

carmiibimbness..

WebSphere® Support Technical Exchange

= Objects/Classes are sorted
by TotalSize
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Objects by Size

= |IBM HeapAnalyzer

File Analysis Yiew Help

heapdump1.ha Objects View :

TotalSize

Size ¥

Mo.Child

Address

7875 040

393,232

47 766

Ox3feZedds

array of camfi...

7,888,160

393,232

47 785

Ox3fdEe37a

array of camfi...

7,893,088

393,232

47 137

Oxafasdael

array of camfi...

7,868,672

393,232

47115

Ox3feee3dbd

array of camfi...

7,882,112

393,232

47017

Ox3fdce38s

array of camfi...

7,876,064

393,232

47 077

Ox3feBedal

array of camfi...

F9,572 GA0

F3,064

17,011

Ox3671ab03

array of camfi...

499 496

£3,064

17,011

Ox36733188

array of camfi...

B5 557

F5 567

1]

0x33287480

primitive array

741,552

49,165

4 367

Ox3ffaed 48

array of camfi...

741,552

49,165

4,528

Ox301fchi0

array of camfi...

742,274

49,165

4,578

Oxaffdeldch

array of camfi...

741,888

49,165

4,330

Dx3ffEGE3ed

array of camfi...

741,552

49,165

4,584

Ox3ffch4 63

array of camfi...

741,552

49,165

4,584

Ox3ffa2438

array of camfi...

741,552

49,165

4,508

Ox3f964 28

array of camfi...

741,552

49,165

4,572

Ox3ffd2478

array of camfi...

741,888

49,165

4,578

Ox3ff5a3dB

array of camfi...

741,888

49,165

4,841

D37 2318

array of camfi...

741,552

49,165

4,508

Ox3ff3a418

array of camfi...

741,888

49,165

4,843

Ox3ff7ed0d

HeapfAnahzer|List of Objects sorted in various order

array of camfi...

WebSphere® Support Technical Exchange

= Objects/Classes are sorted
by their sizes
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Objects by number of child

IBM HeapAnalyzer
File Analysis View Help

heapdump1.ha Ohjects Yiew

TotalSize Size Mo.Child W Address

T EE31E0 383 232 (4T 285 M3fdBe3T 8 |array of comii.. | =
TATa B840 393,232 |47 266 OxafeZeddsd |array of comibi. | =
T.893,088 (393,232 |47 132 Ox3fagdael |array of comii...
7863672 (393,232 |47 114 Ox3feeedbd |array of comii...
TATE 064 (383232 4T 077 Dx2feBe3ald |array of comii..
Taa2 11z (393,232 47017 Ox3fdce388  |array of comii...
499 496 ga2,064 |17 011 036723188 |array of comii...
B9,572 6230 (62,064 |17 011 Dx36TT3b0E  |array of comii...
2632272 48168 |6 2467 Dx3dd64338 |array of javal..
25,056 9234 (40976 |5,1591 Dx20ad7d700 |array of javall...
741,552 49168 4,804 0x2f2ad18  |array of comii...
741 552 49168 (4,898 Ox3M96E428  |array of comii...
741 852 49168 4,884 DxaffcB468  |array of comii...
741 652 49168 4,884 Dxaffazd438  |array of comii...
741 888 49168 (4,873 Ox3ffaadds  |array of comii...
T42 224 49168 4,878 Ox3ffdedcd  |array of comii...
741,852 49168 |4,872 Q32478 |array of comii...
741 552 49168 |4,867 Ox3ffaedds  |array of comii...
741 888 49168 4,843 Maftred08  |array of comii...
T41 8883 49168  |4,841 Daffy23ara  |array of comii...
741,888 49168 (4,830 (wafEE el

A,

array of camfi...

Heapinalyzer List of Objects sorted in var r
F o=k

WebSphere® Support Technical Exchange

ious orde

= Objects/Classes are sorted
by number of child objects
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Objects by address

heapdump1.ha Ohjects Yiew

IBM HeapAnalyzer
File Analysis View Help

TotalSize Size Mo.Child | Address W
256 1] Ox7Ta3zbald |class javas .
266 1] Ox7Ta32bd18 |class javax .
296 1] 0x7a3zb313 |class javara...
206 1] Ox7adZb218 |class javada...
206 2 Dx7a32h118 |[class comiib...
256 1] 0x7a3z2b01a |class javaw .
256 1] OxTaizaf g |class javas .
266 1] OxTaiZaeld |class javax .
296 1] Ox7adZadld |class javax..
206 1] Ox7adZacla |class javax..
206 1] Dx7a32ahl1l |class [Liawax...
256 1] Dx7adZaald |class javaw .
256 1] OxTa3zaf18 |class javax .
246 1] OxTa3zad18 |class javax .
296 1] Ox7adzadla |class javax..
206 2 Ox7adZaB1d |class javax..
256 1] 0x7a3dZag1d |class javaw .
256 1] 0x7a3dZad1d |class javaw .
256 1] OxTa3izails |class javax .
246 2 OxTaizaZz18 |class javax .
296 1] Ox7adzal1d |class javax..

ious order

Heapinalyzer List of Objects sorted in var
3 | —— I
g_ -A
F oEs

WebSphere® Support Technical Exchange

= Objects/Classes are sorted
by address
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Objects by name

IBM HeapAnalyzer

File Analysis View Help

[ heandump1.ha Objects View = Objects/Classes are sorted

Qhject ¥ TptaISi.. Address

javallanglrefiFinalizer 132,352 0x304 ... by na me

javallanglrefiFinalizer 132,448 Qu304...
javallandlrefiFinalizer 3,360 0x303...
javallanalrefiFinalizer 32 0x302...
javallanalrefiFinalizer 3,264 Qx381..
javallangirefiFinalizer 121,528 D338
javallanglrefiFinalizer 119,963 Qu3ca...
javallanglrefiFinalizer 124,288 Nu366...
javallandlrefiFinalizer 123,456 Qu301..
javallandlrefiFinalizer 124,320 (x366...
javallanalrefiFinalizer 125 696 Ox334...
javallangirefiFinalizer 1,184 D313
javallangirefiFinalizer 2,592 Qu321 ...
javallanglrefiFinalizer 32 Qu3b1 ...
javallanglrefiFinalizer 125,888 Qu3dZ..
javallandlrefiFinalizer 32 Ox302...
javallanalrefiFinalizer 32 0x317...
javallanalrefiFinalizer 133,120 Ox301 ...
javallangirefiFinalizer 129,344 D306,
javallanglrefiFinalizer 113,368 Qu310...
javallanglrefiFinalizer 26,934 Nu338...

[T U VY g Uy P U U B R U BN rog preuy BT reuy T T prey prey g

HeapAnahyzer|List of Objects sorted in various order

WebSphere® Support Technical Exchange
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Types by Name

= IBM Heapﬁmnl"zer

Tree view

e
__

S(i=1E3

= List Types -> Sort by Name

Ohjects List

Gaps by size
Gap Statistics

ove Bookmark | eak Suspects

nerOfChildObhject(159,549) Mame Address
2 comdibrmdrmifiiopfC DR OutputStream 0x3
28] 35 coamfibrmfCORBAGIOpMIRE 0x36864

Search

2 [48] 6 comdfibmfejsioa/EJSRootOAlmipl O

T 1 IR =g

2704 [24] 1 comfibmiejsiutifFastHashtabl

o [CJ 69,572,680 [62,064] 17,011 array of cormfitim

o= [ 7,895,296 [24] 2 comiibmie]siutilBucket
o= [ 7,890,268 [24] 2 comiibmiejsiutilfBuc ket
o= [ 7,884,320 [24] 2 comiibmie)siutilBucket
o= [ 7,878,272 [24] 2 comiibmiejsiutifBucket
o= [ 7,878,048 [24] 2 comiibmiejsiutilfBucket
o= [ 7,870,880 [24] 2 comiibmie)siutilBucket
o= [ 744,432 [24] 2 comfibmiejsiutilBucket Ox
o= [ 744,086 [24] 2 comdibmiejsiutillBucket Ox
o= [ 744,086 [24] 2 comdibmiejsiutillBucket Ox
o= [ 744,086 [24] 2 comdibmiejsiutilBucket Ox
o= [ 744,096 [24] 2 comdibmiejsiutillBucket Ox
o= [ 743,760 [24] 2 comfibmiejsiutilBucket Ox

WebSphere® Support Technical Exchange
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Types by Name

£ IBM HeapAnalyzer

File Analysis View Help

heapdump1.ha Types View ©

Sum of sizes

Count

38

SURSSeCUrtE 095, |

g1

SUNSsecUrita09rc.

30

sunfsecurityxa09/8. .

11

sunfsecurita 00,

176

suUnfsecuribyxb 088

723

SUnSsecuritxa0ann,

275

sURSsecUritutilich]...

Far

suUnfsecuribdutiliCoar. .

Far

sunfsecuributiliDer...

Far

sunfsecuributiliDer...

1

sunfsecuriteutiliByt. .

—

sunfsecurityutiliByt. .

(a3}

sunfsecurityutiliBial...

sUnfsecuritdprovide. ..

sUnfsecuritprovide. .

sunfsecurityprovide. .

sunfsecuritiprovide. .

sunfsecurityprovide.

sunfsecurityprovide.

ECY

sUnfsecuritdprovide. ..

g
1
1
2
2
]
1
]
3

sUnfsecuritprovide. .

WebSphere® Support Technical Exchange

= Types are sorted by their

Nnames
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Types by Size

IBM HeapAnalyzer
File Analysis View Help

heapdumpi.ha Types View -

Sum of sizes ¥ Count
23,021 840 aTH 540 corribrmirmifjava. . |-
22,350 368 218,584 arimitive array =
18,627 008 araaEa comfibmirmifutilfide. .
13,737,576 ar2, 399 comfibmignksoftteg...
9157 643 ar23a3 FProwyE
5,474 880 171,090 janallangrString
3,901 696G 1,867 array of camifitimirm...
2172000 BT BTA javalutifHashhaps. .
2,029,400 37,009 array of javallanoic ...
1,534,224 21,165 array of javaiutiliHa...
998 376 17,8248 javalutifHashhkanp
951 672 39 653 camifibrmiejsiutiliBu. ..
854 976 26,7148 javalutifHashtahled. .
a81,4842 3163 comfibmirmifiioplc .
246,016 G126 array of javaiutiliHa. .
369192 15,383 jamarutilfArravList
336,000 14,000 comlibmiws/cacheal .
281,928 11,747 comiibmirmiiProfile. .
266,592 A,564 javaliutifHashtahle
211,288 2,401 javalutilfSimpleTim...

187,248

164

—

comfibmiejsiutilicac...

us order

Heapinalyzer List of Types sorted in vario
A I P 3
g_ -A
F o=

WebSphere® Support Technical Exchange

= Types are sorted by sum of
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Types by frequency/count

£ IBM HeapAnalyzer |-_| |E| |E|

File Analysis View Help

heapdump1.ha Types View

= Types are sorted by

Sum of sizes Count ¥ Twpe
266 582 5554 jawaiutilHashtahle - freque ncy
156,384 4837 comfibmiejsiutilfEle.. | =
131,352 4,610 array of javalsecurit. .
141 G496 4,428 javaiutil®ectar
112,928 36249 jawaiutiliAahstractlist..
108,192 3,381 javalsecuribhfAcces .
TH 224 3,20 comfibrmsmesipmilse.
BY 834 3,244 array of javaflanofCl...
581,992 3163 cormfibrfrmifiioplc.
47 648 2878 javaiutilHazshSet
98 336 24967 array of javallanglst. .
44 864 2,804 javaiutilljarattributes
43168 2,648 javaiutiiHashMap§2
172,224 2641 orgfapachelstrutsiut..
41 648 2,603 javaiutiiHashMap§i1
61,128 2547 jawasutiiLinkedLists. .
70,232 2,408 array of javaxfsecuri...
80,192 24806 jawasutiiLinkedLists. .
60,144 2,506 javaxisecurihiauthi.
38,720 2,420 javaiutiliHashMap$a
211,284 2401 jawasutilSimpleTim. ..

Heapanahl/zer|[List of Types sorted in various order

n I = [ .
¢ K i
‘ .= oy 3 .

WebSphere® Support Technical Exchange




| IBM Software Group

Gap Statistics

Tree view

Objects List
Types List

(=13

ove Bookmark | eak Suspects

aerOfChildOhjecti! 99,549 Mame Address

Search

Gaps hy size 2 comlibrmiirmifiiopfC DR OutputStream 0x3

gza] 25 comlibmiCORBATIDIORE Dx36864

2 [48] 6 comdibmiejsfoalEJSRootOAlImpl O

T —roo=rs, 04 [24] 1 comdibmiejsiutilF astHashtabl
9 [CJ 69,572 680 [62,064] 17,011 array of camfibm

o= [ 7,895,206 [24] 2 comlibmiejsiutiliBucket
o= [ 7,890,368 [24] 2 comiibrmiejsiutilfBucket
o= [ 7,884,320 [24] 2 comlibmiejsiutiliBuclket
o~ [ 7,878,272 [24] 2 comiibrmiejsiutilfBucket
o= [ 7,878,048 [24] 2 comlibmiejsiutiliBucket
o~ [ 7,870,880 [24] 2 comiibrmiejsiutilfBucket
o= [T 744,432 [24] 2 comdibmiejsiutilBucket Ox
o= [ 744,096 [24] 2 comiibriejsiutilfBucket Ox
o= [ 744,096 [24] 2 comdibmiejsiutilBucket x
o= [ 744,096 [24] 2 comiibriejsiutilfBucket Ox
o= [ 744,096 [24] 2 comdibmiejsiutilBucket x

o= [ 743,760 [24] 2 comiibrmiejsiutifBucket Ox

HeapfAnalyzer Gaps distribution chart
. I | . |
g_ -
F oSS

WebSphere® Support Technical Exchange

= Analysis -> Gap Statistics
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Gap space view

= IBM HeapAnalyzer
File Analysis Wiew Help

heapdump1.ha Gap analysis

Mumber of gaps by size
161 223

]

Lo ¥ o o o o o o o

= bl e LTI =000 00—
oooooooooOs
[ ¥ o o o o o o T o
o oooooooooo

'
[

E- -"H'H 4 r.| L £

PHe— ot

T =7 = T T

100 1K 10K 100k 1M

Gap size (byte)

100 100M1G

100M - 9959M
15 -

HeapAnahzer | Gaps distribution chart

= = ey,
e N

WebSphere® Support Technical Exchange

= Gap space distribution view
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Options menu
= You can configure
setting in View ->
Options menu

Options
Mazimum number of sub-trees 2D|
Maximum number of super-trees 100
How many more subisuper-trees to display 7 110
100,000,000

Mininum total size drop for search (inte)

Cancel

Apply

WebSphere® Support Technical Exchange
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Search Objects

= =1E3

Wiew Help

R = Search object -> Sort by
Objects List A SRURMTools\HeapAnalyzereducationih .
Types List | TotalSize
- ol AL build ca131-2003061 2
Gaps by size

asses. 7300 Ohjects: 2910270 ChjectArrayvs
Gap Statistics v}

1o IR, ., . ;2151 5

Heap range size © 1,244,373,136
Heap size : 119,180,536

HeaphAnahyzer |Search obhjectstypes and sort

WebSphere® Support Technical Exchange
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Find types and objects

= Address by type to
find types include

's.*-.{; Find an address
Please enter type or regular expression
string “byte”

(For example ."byte.” for types include string “yte™)

| *yte.*

Cancel

‘ Find |

WebSphere® Support Technical Exchange
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File Analysis View Help

heapdump1.ha Search

L

S O

Search objects/types

= |BM HeapAnalyzer

4

TotalSize ¥

Size

Mo.Child

Address

Chiject

69,572 704

24

Ox367eb1 63

comdibm/ie...

F9,572 650

53,064

7.011

Ox367F3h08

array af co...

35,057,016

32

Ox303e10c8

javalutilte

18,210,554

43

0x305ddfE0

javalutiliHa. .

18,210,536

64

0x305ddf20

array of jav...

18,208,760

32

0x3196d308

javalutiliHa. .

18,208,500

32

0x3196d360

javaiutilite. ..

17,027,760

¥

Ox3af07c0

comdibimbe...

17,027,280

24

Ox35f8a73b

array of co...

17,015,504

56

Ox337d4a23

javalutiliHa. ..

17,014,448

B4

Ox314312c8

array of jav...

17,015,256

32

Ox34f099c8

javalutiliHa. ..

17,014,144

i

Ox34dfeq00

comdibimhe. ..

17,017,630

56

Ox34dfesas

javalutiliHa. .

17017 624

112

Dx3027E390

array of jav...

17,008,536

32

Ox302ac0c0

javalutiliHa. .

17,007 616

il

0x371dedhd

comdibima...

16,672,088

56

Ox33cEfc0o

javalutiliHa. .

16,572,016

T84

=2}

Ox386329990

array of jav..

15,644 952

32

Ox34a420a0

javalutiliHa. .

15,640,576

32

Pl [l | D R D | DD (00| = | P P [ | = | BD | | = (D L — | — | = —

030343788

javalutiliHa. .

Heapinahzer Search objectsftypes and sort

WebSphere® Support Technical Exchange

= The following is the list of
types which have “byte” in
their names.




| IBM Software Group

Search Objects, Sort by Size

IBM HeapAnalyzer

File Analysis View Help

heapdumpi.ha Search

TotalSize

Size ¥

ro.Child

Address

¥,8288 160

383,232

47,285

Dx3flfedy s

array of co..

7,876,064

393,232

47,077

Ox3fe8eiald

array of co...

¥a82112

383,232

47 017

Ox3fddce3dd

array of co...

¥,8493,085

343,232

47132

Ox3fasdaeld

array of co..

¥,068 672

363,232

47115

Ox3feeeibd

array of oo,

7,875,840

393,232

47,266

Ox3fele3qa

array of co...

B9,572 BE0

BS,064

17,011

Dx36713008

array of co...

499,496

6E,064

17,011

Ox367E3138

array of co...

T41,552

449,168

4,828

0301 fcha0

array of co..

2,632,272

49168

6,267

Ox3cddh4338

array of jaw...

741,858

49,165

4,843

Ox3ff7ed408

array of co...

741,552

45168

4,898

Dxaff96428

array of co...

741,552

449,168

4,813

Dx3ffhadas

array of co. .

F42224

44,1645

4,874

Ox3f4edca

array of co..

T41,852

491648

4,867

Ox3ffaed 48

array of co..

741,552

49,165

4,372

Dx3ffd 2478

array of co...

741,884

48168

4,841

Ox3ff7 2313

array of co...

741,552

449,168

4,584

Dx3ffeG463

array of co..

741,552

44,1645

4,894

0x3ffaa418

array of co..

741,858

49,165

4,378

355308

array of co...

741,552

49,165

4,884

Ox3ffa2438

array of co...

Heapfnalyzer Search objectsiypes and sort

WebSphere® Support Technical Exchange

= Objects are sorted by Size
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Find a type

= Search for object/type _ = You can also enter

Please enter type or regular expression exact name of a type:
javal/lang/String to

(For example .*wte.” for types include string "nte") , _
get more information
about a type

|javaf|ang15tring|

Cancel

WebSphere® Support Technical Exchange
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Find a type

IBM HeapAnalyzer

File Analysis VYiew Help

heapdump1.ha Search

TotalSiz... ¥

Sizeis 474,

Mo, Child

Adddress

42168

32

0x2400f220

javallanals...

25,5592

32

0x352356e48

iavallangls...

22,312

32

0x30365038

javallangls. .

22120

32

0x3523c4h0

javallano/s. .

21,672

32

0x35705818

javallanls...

21,282

32

Ox34d4ddcra

javallanals...

21,104

32

Ox2400f340

javallangls. .

21,080

32

0x34d52edd

javallano/s. .

21,064

32

Ox35acddbn

javallanols...

32

0x34014a08

javallanals...

32

Ox35746238

javallangls. .

32

Ox3aTF4cads

javallangls. .

32

0x35704130

javallano/s. .

32

Ox356eald3a

javallanals...

32

0x37he5330

javallangls. .

32

0x300c8250

javallangls. .

32

0x356ehs28

javallano/s. .

32

0x2357 106

javallanals...

32

D357 0c5d0

iavallangls...

32

O0x35712608

javallangls. .

32

—_m|l_ml=ml—_m_m=m—m=m—_m=m == =m === == == =

Ox3570e5c0

javallano/s. .

WebSphere® Support Technical Exchange

This is the list of
types of
javallang/String
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Status bar

= |[BM Henpﬁmnly.-_t-r

] heapdump m g

T ECF: Tatal: 3229558 Classes: 7300 Dbjects 2910270 Objectirrays
mHumber of roots @ 159,549

Fumber of types : 10 664

Heap range : 030070200 to 0xFadzbats

Heap range size : 1,244,373,126

Heap size 119,180,536

WebSphere® Support Technical Exchange

= You can hide/show
Status bar

= Status bar is used to
display description of
each menu
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Console

= . |BM HeapAnalyzer

File Analysis

heapdump

Options
¥ Statushar

T ECF: Total: 3229668 Classes: 7800 Ohjects: 2910270 Ohjectirrays

mHumber of roots @ 159,549
Fumber of types : 10 664
Heap range : 030070200 to 0xFadzbats

Heap range size : 1,244,373,126
Heap size 119,180,536

HeapiAnalyzer | ShowHide Console

WebSphere® Support Technical Exchange

= You can hide/show
Console
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Common Exceptions/Errors

= Exception in thread "main" java.lang.NoClassDefFoundError:
java/util/regex/PatternSyntaxException

HeapAnalyzer requires Java 2 SDK 1.4.1 or higher.
The exception is thrown if older versions SDK is used:

= java.lang.StringIndexOutOfBoundsE xception: String index out of range: 0

at java.lang.String.charAt(Unknown Source)
at com.ibm.jinwoo.heap.FileTask$ActualTask.<init>(FileT ask.java:386)

at com.ibm.jinwoo.heap.FileTask$1.construct(FileTask.java:794)
at com.ibm.jinwoo.heap.SwingWorker$2.run(SwingWorker.java:45)
at java.lang.Thread.run(Unknown Source)

You can see this exception while processing corrupted heapdumps or
truncated ones. Truncated or corrupted heapdumps are not reliable

WebSphere® Support Technical Exchange
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Common Exceptions/Errors

= Exception while parsing line 9 : 0x0x50003070 [1000] java/lang/String

java.lang.RuntimeException
at com.ibm.jinwoo.heap.FileTask$ActualTask.<init>(FileTask.java:321)

at com.ibm.jinwoo.heap.FileTask$1.construct(FileTask.java:794)
at com.ibm.jinwoo.heap.SwingWorker$2.run(SwingWorker.java:45)

at java.lang.Thread.run(Unknown Source)

Some old Linux IBM SDKs generate invalid address in heapdumps. After
replacing 0x0x with Ox, HeapAnalyzer can process heapdumps.

= java.io.lOException: Not in GZIP format
at java.util.zip.GZIP InputStream.readHeader(Unknown Source)

at java.util.zip.GZIP InputStream.<init>(Unknown Source

at java.util.zip.GZIP InputStream.<init>(Unknown Source
at com.ibm.jinwoo.heap.OpenTask$ActualTask.<init>(OpenTask.java:32)

at com.ibm.jinwoo.heap.OpenTask$1.construct(OpenTask.java:111)
at com.ibm.jinwoo.heap.SwingWorker$2.run(SwingWorker.java:45)

at java.lang.Thread.run(Unknown Source)

You can see this exception when you try to load invalid .ha file.

WebSphere® Support Technical Exchange
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Common Exceptions/Errors

= Format error while parsing line 10 : 0x50004050 0x50004050

Unexpected format in heapdump. Possibly it's corrupted heapdump.
Further analysis is unreliable.

WebSphere® Support Technical Exchange
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Java heap analysis: Example1

= IBM HeapAnalyzer

Vector v1 = new Vector();

for(lnt |=O;|<1 OO;|++) G0 to Bookmark Remove Bookmark Leak Suspects
{ | TotalSize [Size] MumberOfChildObject{Y06) Mame Address
. _ . . 9 [ 1,606,128 [32] 1 javaiutili/ector Ox102a93d8
Int[] S1 = new Int[1 OOO]’ ¢ [ 1,606,096 [1,296] 200 array of javailang/Ohject 0x1037 7ed
|Ong[] s2 = new |Ong[1()()()]; [} 8,016 [8,016] 0 long]l 0x103a8380
_ . |j‘| 2,016 [2,016] 0 long 0x102351ba0
ﬂoatl] S3 = new ﬂoat[1 000]’ |j‘| 8,016 [8,016] 0 long) 0x102acte
vi.add(s1); [ 8,016 [3,016] 0 longl 0x103ac230
V1 add(SZ), |j‘| 2,016 [2,016] 0 long 0x102d3170
|j‘| 8,016 [8,016] 0 long Ox10355a00
V1 .add(sB); [} 8,016 [8,016] 0 lona 0x103b00e0
} |j‘| 2,016 [2,016] 0 long 0x10231adhbo

|j‘| 8,016 [3,016] 0 long[] 0x10273340
|j| 3,016 [3,016] 0 long[] Ox103b31H0
E‘| 8,016 [2,016] 0 long[] 0x10359800

|j| 8,016 [3,016] 0 long[] 010236950
I

HeapAnahszer|[List of Types sorted in various order

WebSphere® Support Technical Exchange
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Java heap analysis: Example2

Vector vO = new Vector();
Vector v2 = vO;
for(int i=0;i<100;i++)

{

Vector v1 = new Vector();
int[] s1 = new int[1000];
long[] s2 = new long[1000];
float[] s3 = new float[1000];
v1.add(s1);

v1.add(s2);

v1.add(s3);

v2.add(v1);

v2=v1;

= |BM HeapAnalyzer

heapdump.20050914.122249.5948.txt Tree View

Goto Bookmark HRemove Bookmark Leak Suspects

[ | TotalSize [Size] MumberOfChild Ohject{T068) Mame Address
o [ 1,613,628 [32] 1 javaiutindector 0x102298k00
9 [ 1,613,656 [56] 1 array of javallaniOhject 0x102a9878
o [ 1,612,600 [32] 1 javaiutifector 0x1 0229848
9 [ 1,613,568 [56] 4 array of javafdang/Object 0x1 0229820
o 11,597,464 [32] 1 javaiutiliector Dx1 0225950
o ] 1,597,432 [96] 4 array of javailangfObject 0x1 022591
o [ 1,581,328 [32] 1 javaiutildectar 0x102a1248
9 |j|‘l A1, 2486 [36] 4 array of javalana/Ohject 0x1
o= 1,565,192 [32] 1 javalutilvvector 0x102a1 G
D 2,016 [2,016] 0 long[] Ox102acfal
|j| 4 016 [4,016] 0 int] Ox102ac030
D 4016 [4,016] 0 float] 0x1025ef30

[ 2,016 [2,016] 0 long] Ox102aZals

I A D4R T DA S0 et Daed O d RS

HeaphAnahlzer|vView Heap dump Tree sorted bn Total Size

WebSphere® Support Technical Exchange
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How to analyze Java heap

= IBM HeapAnalyzer

File Analysis View Help

heapdump2.ha Types View 5

Count W

Sum of sizes

584,701

18,870,432

5845 421

FEB,322 648

iavalutilHashtable$Entry

104,754

3,253,085

javaliutilTreemMapFEntry

78,4149

3,136,760

skiregobiauthorizationiau...

F2812

1,747,488

array of javaflangfOhject

51,931

23,563,640

bool[]

46,171

1,133,536

comdibmiejsiutilfBuc ket

39137

939,258

38,551

1,233,632

35,047

60,848

25803

45,995 792

orafapachelercesiimplixs.

21102

1,250,525

array of arofnw3cidomistr

21,081

431,816

orgfapachemliidimsireifEx. ..

20,075

42,400

javaiutiltiector

20,0449

41,568

comfibmfwsicachel/Bucket

20,000

430,000

array of argfapacheerce. ..

19,485

1,102,480

bryte (]

18,230

15,492 992

orafapachelamliutilsiata..,

17,520

S60,540

argfapacheiercesfimplixs. .

17,504

240,192

HeapAnahlyzer List of Types sorted in various order

WebSphere® Support Technical Exchange

= Review number of objects
by selecting List Types ->
Sort by Count

= If you see excessive
number of objects, pay
attention to them.

For example,
DB2PreparedStatements
MQQueueManager
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How to analyze Java heap

2 IBM HeapAnalyzer
File Analysis View Help

heapdump2.ha Tree View -

Go to Bookmark Remowve Bookmark Leak Suspects

15ize [Size] MumberOfChildObject(29,241) Mame Address

47 846,128 [304] 3 class orgfapachefmifiutilsiMLREeadermanager Ox
1 147,555,824 [24] 2 orgfapachesmliiutilsiMLReadermanager 0x3202

¢ [ 147,555,794 [48] 1 javaiutiiHashtable 0x3027 2508

9 [CJ 147,555,736 [3,088] 262 array of javalutiiHashtable$Entry 0

-1,
-1,
-1,
-1,
o= 31
=31,
=31,
o= 3 1
=31,
=31,
o 51
o1,

Q96 720 [32] 3 javalutilHashtahlefEntry 0x33123188
96 720 [32] 3 javalutilHashtahlefEntry Ox3h23d7hE
G21,384 [32] 3 javafutifHashtableFEntry Ox3ce0d 208
GOE 400 [32] 3 javalutilHashtablefEntry Ox3c 264508

JB08 296 [32] 3 javalutifHashtablefEntry Dx38fee118

218 976 [32] 3 javalutifHashtablafEntry Ox363992 b3
218 976 [32] 3 javalutifHashtablefEntry 0x3380c230

218,872 [32] 3 javaiutiiHashtableFEntry 0x3a92c4e8

201,984 [32] 3 javaiutiiHashtablefEntry Ox3ceccfald
201,920 [32] 3 javalutifHashtableFEntry 037262018

201,880 [32] 3 javanutiiHashtableFEntry 0x3f9da100

201,744 [32] 3 javaiutiblHashtablefEntry Ox3d03dcal

WebSphere® Support Technical Exchange

= Review Tree view

= Look for areas where
excessive number of
child with large
difference in total size
between parent and
child
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How to analyze Java heap

= You cannot diagnose all problems by analyzing Java heap
dumps. Java Heap dumps are just snapshots of Java heap at
specific times. Garbage collector trace is another source of
information to figure out what’s going on with Java heap and
garbage collector.

= To diagnose Java heap usages, enable garbage collector
trace and analyze the trace with
IBM Pattern Modeling and Analysis Tool for Java Garbage
Collector
available at http://www.alphaworks.ibm.com/tech/pmat

WebSphere® Support Technical Exchange
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How to copy/paste content

£ . IBM HeapAnalyzer |:| |§| |E|

heapdump1.ha Tree View &

cooof B

Go to Bookmark Remove Bookimark Leak Suspects

| TotalSize [Size] MumberOfizhildChject{1 99, 549) Rlame Address
o= [T] A7, 290,640 [200] 2 comdibmirmifiiopd DR OutputStream Ox3
o- 5] 309,056 [256] 3 class javalutiljardarFile OxFO07c0q &

o |j|1 93,248 [2596] 22 class comdibrmsrmmifuti F_Hility Ox7 611007 E|
o= [ 134,112 [32] 4 javallanaireflFinalizer 0x300d69e0

o- [ 107,808 [256] 20 class comfibmirmiliofObjectStreamClass

F

: S Document - WordPad |:||E||E|
| File Edit View Insert Format Help

TOlDEEd S # LB B

o (==l

o= ] |.Pu'ia| v||'H] v||Westem « B 7 U
:S 3'1'2'3'4

o= )| TotalSize [Size] NumberQfChildObject(159,549) Name Address

o ] 97,250 640 [200] 2 comfibm/rmifiiop/COROutputStream 0x3016d7b0

o 1] 309,056 [256] 3 class javalutilfjar/JarFile 0x7007c018
o= [ 193,248 [256] 22 class com/ibm/rmifutil/Utility 0x76110018

For Help, press F1

= KeyBoard
Copy: Control-C
Paste: Control-V

= Mouse
Select, drag and drop to
word processors or
editors that support drag
and drop

WebSphere® Support Technical Exchange
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Memory Dump Diagnostic For Java

= Next generation memory leak analysis tool with
best-of-breed features from HeapAnalyzer,
HeapRoots and Leakbot

= Technical Preview with WebSphere Version 6.0.2.
Download from WebSphere Developer\Works:

WebSphere Technology Previews jod o
\oad \J“‘
Do‘N“s_\ a0 109

u

= Fully supported version to be available with IBM
Support Assistant

WebSphere® Support Technical Exchange
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Main Functions in Memory Dump Diagnostic
for Java

= Detects Memory Leaks
» Single Dump Analysis

» Comparative analysis of two memory dumps
Visualizes Memory Dump contents
Analyzes Java Memory dumps

» IBM heap dumps (text & binary)

» HPROF dumps

» SVC dumps (z-series)
Detects growing data structures as opposed to low level

objects
Shows footprint of application heap usage

WebSphere® Support Technical Exchange
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Additional WebSphere Product Resources

Discover the latest trends in WebSphere Technology and implementation,
participate in technically-focused briefings, webcasts and podcasts at:

Learn about other upcoming webcasts, conferences and events:

Join the Global WebSphere User Group Community: www.websphere.org
Access key product show-me demos and tutorials by visiting IBM Education

Assistant: ibm.com/software/info/education/assistant

Learn about the Electronic Service Request (ESR) tool for submitting
problems electronically:
v;/]WV\Il.ibm.com/software/support/viewlet/probsub/ESR_Overview_viewlet_swf
.htm

Sign up to receive weekly technical support emails:
www.ibm.com/software/support/einfo.html

WebSphere® Support Technical Exchange
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Questions and Answers

WebSphere® Support Technical Exchange



